
Release Notes 7.0.24 

Release Date: May 16, 2026 

 

https://www.motivewave.com/download.htm 

 

To see these updates in action, visit our social media channels for a quick demonstration video. 

https://t.mtrbio.com/motivewaveSocials 

 

Important Note: Data formats have changed in version 7 of MotiveWave.  Workspaces created 

using older versions of MotiveWave will be forward compatible (ie they can be used in Version 

7) but once the workspace has been opened in version 7, it will not be able to be opened by older 

versions.  Please consider creating a new workspace for version 7 testing and restore from a 

backup of an existing workspace. 

Version 7.0.24 

This version contains numerous bug fixes and the following features: 

1. CTS Connector –Updated to latest websocket implementation 

2. Volume Imprint – Added horizontal indicator to ladder view to show Open/Close when 

these values are the same. 

3. Trade History 

a. Trade Lines – added option to color the connector lines based on profit or loss 

b. Marker Offset – Added option to adjust the distance from the candles 

4. Profit Loss Component – added options to display profit/loss in Ticks/Price Movement 

5. Price Graph Scaling – added new option to set a specific price range 

6. Study Graph Scaling – Added scaling options for Auto Scale, Range and Specific 

Range 

7. Component Bar – Added option to disable the display of this bar.  See All Charts - 

Options 

Version 7.0.23 

This version contains numerous bug fixes and the following features: 

1. Rithmic Connector –Updated to the latest Rithmic Native Connector.  Added 

connections for NYC Area and additional prop firms. 

Version 7.0.22 

This version contains numerous bug fixes and the following features: 

1. Trade History –The font/color can be chosen for Buy and Sell text.  Added +/- signs for 

quantities 

2. Keyboard Shortcuts – Added the option choose a keyboard shortcut for ‘Remove Filled 

Orders’ 

3. Volume Imprint  

a. Added options for developing POC, VAL and VAH. 

b. Add “Neutral” Bar Color option 
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4. TPO Study – Option to choose ETH value area bar color. 

5. MacOS – Downgraded to Java 25.  Some users were experiencing crashes on macOS.  

6. Chart Performance – Drag and bar width adjustments for non-linear charts have been 

improved, resulting in smoother performance when rendering large amounts of tick data  

Version 7.0.21 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Java 26 – Updated to the latest Java/JavaFX runtime environment. 

2. Alerts & Study Signals – To improve startup performance, study and component-based 

alerts and signals are no longer loaded at startup. They will now load on demand once an 

instrument's chart is open and historical data has been loaded. Important: If you rely on 

these alerts or signals, ensure you have an active chart open with historical data loaded 

for the relevant instrument. 

Version 7.0.20 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Trade History – Added configuration options to change the color and line style for the 

trade markers displayed in the trade history. 

2. Time & Sales / Order Book – Added options to import and export templates 

3. Rithmic Native – Native (C++) connector for Rithmic will now load up to 2 years of 

historical executions (trade history). 

4. Order Heatmap – Changed the default heatmap colors and added a contrast slider.  

Version 7.0.19 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. DOM – A new option was added to keep the last price visible in the DOM table (see 

DOM Settings -> General tab). 

2. Time & Sales Panel – Removed the “Rows” option from the tool bar. 

3. Order HeatMap – Added option to display a tool tip that shows Bid/Ask volume as the 

mouse location. 

4. Volume Imprint – Added a Grey Dot for bars that have the same Open/Close value to 

indicate where the bar closed. 

5. Color Chooser – Added an option to add colors to a favourites menu.  Right click on a 

color and choose “Add Favourites”.   

Version 7.0.18 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Study Legend – Added buttons for hide/settings/delete to the study legend that only 

appear when hovering or when the study is selected.  The hide button will keep the study 

in the legend making it easier to unhide. 

2. Binance – Fixed the login issue for HMAC keys 

3. DOM – Added the ability to change the text color for the volume column 

4. Chart Labels – added a “Semi-Log” label that will show LOG when the chart is in 

semi-log mode 



5. Daily bars from Minute Data – added a global option for this (Configure -> 

Preferences, see “Chart” -> “Options”.  Also added this option to custom continuous 

futures. 

6. Custom Tools – Added a button to the Component Dialog and the right click menu to 

make it easier to create a custom tool from an existing component. 

7. Strategies – Added the ability to display the strategy control panel on the chart instead of 

in the trade panel. 

8. H/L Bars – Added the option to choose H/L bars for studies that contain price bars (such 

as cumulative delta). 

Version 7.0.17 

This is a bug fix only release.  No new features have been added in this update. 

Version 7.0.16 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. DOM Bid/Ask Delta columns – Added option to choose separate colors for the Bid/Ask 

histogram and disable the histogram for negative values. 

2. System Font – Updated the default Inter font that was having some display issues on 

Windows 

Version 7.0.15 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. DOM – Added a histogram option to the Bid/Ask Delta columns 

2. System Font – The font family for the application can now be modified from the 

Advanced Options dialog.  Choose Options -> Advanced Options from the startup 

screen. 

3. Left Tool Bar – The layout for the left tool bar has changed and is enabled by default on 

new workspaces. 

Version 7.0.14 

This is a bug fix only release.  No new features have been added in this update. 

Version 7.0.13 

This is a bug fix only release.  No new features have been added in this update. 

Version 7.0.12 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. TradeStation – Updated to V3 authentication method. 

Version 7.0.11 

This is a bug fix only release.  No new features have been added in this update. 



Version 7.0.10 

This is a bug fix only release.  No new features have been added in this update. 

Version 7.0.9 

This is a bug fix only release.  No new features have been added in this update. 

Version 7.0.8 

This is a bug fix only release.  No new features have been added in this update. 

Version 7.0.7 

This is a bug fix only release.  No new features have been added in this update. 

Version 7.0.6 

This is a bug fix only release.  No new features have been added in this update. 

Version 7.0.5 

This is a bug fix only release.  No new features have been added in this update. 

Version 7.0.4 

This is a bug fix only release.  No new features have been added in this update. 

Version 7.0.3 

This is a bug fix only release.  No new features have been added in this update. 

Version 7.0.2 

This is a bug fix only release.  No new features have been added in this update. 

Version 7.0.1 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Java 25 – Upgraded to Java/JavaFX 25 

Version 7.0.0 

This is a bug fix only release.  No new features have been added in this update. 

Version 7 Beta 13 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Copy Image to Clipboard – This new action will create an image of the active chart and 

paste it to the system clipboard (See Chart -> Copy Image to Clipboard from the top 

menu bar). This will enable you to paste in an email or a document. 



Version 7 Beta 12 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Rithmic Connector – The Rithmic (native) connector has been added back into this 

release for Windows, macOS and Linux as the default connection.  Rithmic’s websocket 

connection (the previous default connector) has been having persistent stability issues.  

This connection has been renamed to Rithmic WS (Beta) until these server related issues 

have been resolved. 

2. Time Axis – When displaying future roll lines, you can optionally display the contract 

for each line. 

3. Custom Continuous Futures – Contract months can now be chosen when 

creating/editing a Custom Continuous Future 

Version 7 Beta 11 

This is a bug fix only release.  No new features have been added in this update. 

Version 7 Beta 10 

This is a bug fix only release.  No new features have been added in this update. 

Version 7 Beta 9 

This is a bug fix only release.  No new features have been added in this update. 

Version 7 Beta 8 

This is a bug fix only release.  No new features have been added in this update. 

Version 7 Beta 7 

This is a bug fix only release.  No new features have been added in this update. 

Version 7 Beta 6 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Exit Strategies – Simple Limit + Stop/Limit strategies are now submitted as native 

orders where supported. 

2. Volume Imprint Total Alerts – added options to draw an outline around totals that have 

met alert conditions. 

3. Avg Entry Indicator – This indicator is now 2 indicators which allows you to set a 

different color for long vs short positions. 

Version 7 Beta 5 

This is a bug fix only release.  No new features have been added in this update. 



Version 7 Beta 4 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Order Input Widget – A new order input widget has been added to the list of options for 

the Trade Panel, Order Book and DOM.  By default this is available on the Order Book. 

2. Custom Rollover Months – You can now customize the months that are included in 

futures contract rollovers.  See Instrument Dialog (right click on a chart and choose Edit 

Instrument), Advanced Tab. 

3. DOM Price Column – Options have been added to show ETH and/or RTH for Open, 

High, Low, Open Range. 

Version 7 Beta 3 

This is a bug fix only release.  No new features have been added in this update. 

Version 7 Beta 2 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Daily Bars Using Minute Data – Optionally, charts using daily bars can have the bars 

built using minute data.  This allows for custom daily bars that are built using the trading 

hours assigned.  This can be enabled from the Edit Instrument dialog (right click on the 

chart and choose “Edit Instrument”) See “Advanced” tab. 

2. Multiple Simulated Accounts – You can now have multiple simulated accounts.  See 

Global Settings dialog (Configure -> Settings from the console menu bar). Click on the 

General tab then on “Simulated Account” tab. 

3. Support/Resist Component – Text can now be added to this component 

4. Default Time Zone – A default time zone option has been added in the Global Settings 

dialog (see General tab). 

Version 7 Beta 1 

Version 7 contains many new features. Please see our YouTube channel for a more 

comprehensive look at this update. 

 

Please Note: This is a beta version of MotiveWave™ and may contain more issues that a regular 

release.  Please report any issues to support@motivewave.com. 

 

1. Complete Charting Rewrite – MotiveWave charting has been complete rewritten to 

simplify the code. 

2. Updated Window Themes – A new Navy theme has been added and the dark and light 

themes have been updated to present a more modern feel. 

3. Window Mode – The previous window mode has been removed and replaced with a 

native window mode and the title bar is colored to match the theme. 

4. Rithmic – Added support for Rithmic’s web API. The previous C++ API was renamed to 

Rithmic Gateway and is available to Windows OS only. 

5. Multiple Connections – Added the ability to connect multiple broker connections of the 

same type to a single workspace (Professional and Ultimate only). 

6. Menus – A new Chart menu was added and will include chart actions that can be 
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completed. The View menu still exists; however, it will show items that can be 

enabled/disabled. 

7. Toolbar Menus – New toolbar menus were created. Click + drag to reorder, select heart 

icon to favorite, right-click for more options such as Remove from Favorites, Assign 

Shortcut, and Customize. New menus were created for: 

a. Instrument Search 

b. Bar Size 

c. Tools 

d. Study/Strategy 

e. Chart Type 

8. Tools – New chart tools were added: 

a. Delta Profile – Draw a delta profile from a chart section. 

b. Highlighter – Freehand drawing tool with transparency. 

c. Pen – Freehand drawing tool. 

d. Popup Note – When selected a note will appear. 

e. Fib Spiral – Fibonacci Spiral. 

f. Path – Multiple line segments connected together. 

9. TPO Study – New features added: 

a. Auto Width – TPO study will auto adjust each bar width when chart is set to 

1-Day and Use Chart Bar Size and Adjust Bar Width are enabled on the General 

tab of the study. 

b. Color Mode – Added a new color mode (Cycle) that will cycle through the 

selected colors starting from period A. 

c. Color – Added the ability to color the TPO letters (Cell -> Color Letters). 

d. Expand/Split – Added a new method to quickly expand a profile (Shift + Click) 

and split a profile (CTRL or CMD + Click). 

10. Multiple Analysis – Titled analysis can be added to an existing chart by selecting the 

analysis folder icon in the top toolbar and selecting the Add Drawings option. 

11. Chart Navigation – New features added: 

a. Chart Scrollbar – The bottom of each chart now contains a chart scrollbar. 

b. Chart Compression – Clicking and dragging the time axis now allows the bar 

width to go below one pixel. This allows more data to be shown in a chart and 

offers a much smoother experience. 

c. Page Forward/Back – The arrows in the bottom left corner of each chart 

function as a page forward/back button. 

d. Reset Chart Scale – The chart context menu (right-click) has a new option (Reset 

Chart Scale) that will put the chart in auto scale, show the current candle and reset 

the bar width to default. 

e. Scroll Sensitivity – Mouse scroll sensitivity options have been added in 

Configure -> Settings -> General -> Mouse. 

f. Magnifying Glass – A new option has been added that will show a popup 

window magnifying your mouse when you move tool points. This can be enabled 

in Configure -> Settings -> Chart -> Chart. 

g. Candles – Regular chart candlesticks no longer have a 3D effect. 

12. Charting – New features and updates for charting: 

a. Hide Study Name – An arrow was added for the ability to show or hide the chart 



study name and values in the top left corner. 

b. RTH Daily Bars – MotiveWave will now build custom RTH daily bars even if 

your data provider doesn’t provide them. On a 1-day bar size chart, right-click 

and uncheck the Extended Session option. 

c. Disable Price Axis – The chart price axis can be disabled in the Chart Settings -> 

Display. This may be useful if you scale the price axis with the DOM. 

d. Right-click Menu – New items added: Add Alert and Add to Watch List. 

13. Strategies – Strategies can now use the chart Cross Trade functionality. 

14. Chart Indicators – New option added to extend the indicator line to the Last Candle 

only (Extend Last Bar option). 

15. Studies – New features for studies include: 

a. Study Templates – Templates can now be created for each study from the study 

dialog. This may be useful for more complex studies such as the Volume Imprint. 

b. Order Heatmap – New option for smoothing the order heatmap. 

c. Multiple Studies – Multiple studies of the same type can now be added to the 

chart even though the key parameters are the same. 

16. Login Screen – New option added to show password on the connection login screen. 

17. Time & Sales – New option to play an audio file when a large trade happens on the bid 

or offer. 

18. Disconnection Popup – New popup dialog when you lose connection. 

19. Edition Features – Features have been simplified and we’ve added more features to 

lower editions: 

a. Indicator-on-indicator, Fibonacci tools, alerts, option chain, Harmonic tools, and 

Gann tools are available in all editions. 

b. Non-linear and second-based bars are available in Standard. 

c. Trade panel and DOM panel customizations and manual symbol mapping are 

available in Standard and Order Flow. 
20. Executions Panel – Rithmic Fill ID column added. 

21. SDK – Changes were made to the SDK in version 7. Custom studies/strategies will need 

to be recompiled. Please see our SDK docs for more details. 

a. Volume Profile classes added. 
b. DOM Notes added. 

Version 6.9.12  

This is a bug fix only release.  No new features have been added in this update. 

Version 6.9.11  

This is a bug fix only release.  No new features have been added in this update. 

Version 6.9.10 

This is a bug fix only release.  No new features have been added in this update. 

Version 6.9.9 

This is a bug fix only release.  No new features have been added in this update. 



Version 6.9.8 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Rithmic – Upgraded to the latest Rithmic connector and added support for 

DayTraders.com  

Version 6.9.7 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Rithmic – Added support for Fast Track Trading, Prop Shop Trader and 4 Prop Trader  

Version 6.9.6 

This is a bug fix only release.  No new features have been added in this update. 

Version 6.9.5 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Schwab – Added support for Charles Schwab Brokerage.  Note: trading is not currently 

supported in this update. 

 

Version 6.9.4 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Coinbase – Updated authentication method to use the latest API Key protocol.  Note: 

Legacy keys will no longer work in this update.  You will need to log into the Coinbase 

website and create a new API key for the Coinbase Developer Platform. 

Version 6.9.3 

This is a bug fix only release.  No new features have been added in this update. 

Version 6.9.2 

This is a bug fix only release.  No new features have been added in this update. 

Version 6.9.1 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Dom/Order Book/Time&Sales – Symbol linking is now available for these panels when 

they are separate from a chart (see link dropdown in tool bar). 

2. Clock – a new dock tab is available (see + drop down) for displaying a digital clock. 

Version 6.9.0 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. New Watch List -The Watch List framework has been re-written in this update: 

a. Format – The format for watch lists has changed in this update, so you will not 



be able to revert to an older version with out losing your watch lists.  Please 

create a backup before upgrading in case you need to go back to an older version. 

b. Quote Sheets – the functionality for quote sheets has been folded into the Watch 

List functionality and there is no longer a distinction between the two.  “Groups” 

have been renamed to “Sections” 

c. Search/Filter – A text box has been added to the dock tool bar to allow you to 

filter the watch list by symbol. 

d. Dock toolbar – the tool bar on the watch list has been re-arranged with less 

frequently used buttons added to an overflow (more) dropdown 

e. Inline Editing – To make editing a watchlist more convenient, inline editors have 

been added to add new symbols.  This option can be turned off by toggling the 

“Edit Mode” option available in the More drop down 

f. Fixed Columns – Similar to the other tables (Positions, Accounts, Orders, 

Executions) the first column in the watch list is “fixed” so that when you scroll 

left/right it stays on the left side.  This can be adjusted via right click. 

2. Table Settings – a new tab has been added to the General Preferences dialog (Configure 

-> Preferences from the console menu bar) has been added under the “Theme” section 

(see “Table” subsection).  This enables you to change colors, arrow type and update 

intervals for all tables. 

3. Time/Sales Panel – The existing Time/Sales panel has been re-written to use the new 

table framework. 

4. Auto Connect – An option has been added to the splash screen to automatically use the 

saved credentials on the login dialog.  Note: this does not work for all connections. 

5. Replay Accounts – Replay accounts can now be used between replay sessions and 

saved/restore on restart of MotiveWave.  To create a replay account see the ‘+’ 

dropdown on the Accounts dock. 

6. Heikin-Ashi Bars – This bar type is now supported for non-linear bars. 

7. Chart Alerts – the look of the chart alerts has been updated.  The font for the alert label 

can now be changed in the Preferences dialog (General -> Fonts -> Chart Fonts). 

 

Version 6.8.8 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Java 21/JavaFX 21 – Upgraded to the latest version of Java and JavaFX.  Note: macOS 

still uses JavaFX 19 due to new issues introduced by JavaFX 21 

1. Volume Imprint – Added the following featues: 

a. Show All – This option has been removed.  Any existing studies that use this 

feature will default to 50 profiles. 

b. Totals – Added the option to display the time per bar (useful for non-linear bars). 

2. VWAP Component – Added an “Underlay” option 

3. DOM – Added hotkey option to reset @Bid/@Ask for all open DOMS (see Config -> 

Preferences from the top menu bar, General -> Keyboard). 

4. Volume Profile Study – Added HVN/LVN functionality (similar to what is current 

available in Volume Imprint) 

5. Orders/Positions/Accounts tabs – Converted these panels to the new table framework.  

All of them have options to display a fixed number of columns. 



6. Table Framework – Choose columns button is now available in the table column header 

(right hand side).  Added an option to display the vertical scroll (on by default).  When 

this option is on, you can click and drag the scroll to browse more quickly. 

7. Trade Report – Converted table to the new table framework.  Sort and columns settings 

are now saved/retrieved properly after restarting. 

Version 6.8.7 

This is a bug fix only release.  No new features have been added in this update. 

Version 6.8.6 

This is a bug fix only release.  No new features have been added in this update. 

Version 6.8.5 

This is a bug fix only release.  No new features have been added in this update. 

Version 6.8.4 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Trade History Panel – The Trade History panel has been re-implemented and renamed 

to “Executions”.  It has the following new features: 

a. Fixed Columns – By default the first column is fixed when scrolling horizontally.  

The number of fixed columns can be changed via right click. 

b. Export Executions Since – There is a new field in the Export Executions Dialog 

to export trades since a given date. 

2. Volume Imprint – Added a new Volume Per Second option to the Totals section 

Version 6.8.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Exit Strategies – Exit Strategy orders can now be modified before the exit strategy is 

submitted.  Just click and drag the orders. You can also cancel exit strategy orders and 

remove the exit strategy via right click on Chart Order. 

2. Console Page Hot Keys – Hot keys can now be assigned to display a specific page in the 

Console/Desktop.   

3. MotiveWave Extensions Directory – The directory location for third party studies can 

be modified from the startup screen (see Options -> Advanced). 

4. Google/Yahoo – Support for stocks from Saudi Arabia. 

 

Version 6.8.2 

This is a bug fix only release.  No new features have been added in this update. 

Version 6.8.1 

This version of MotiveWave contains a high priority fix for Replay mode and the following 



features: 

1. OHLC Study – Added option to show values in the DOM Notes 

 

Version 6.8.0 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. DOM – The Depth of Market (DOM) panel has been rewritten in this update and 

includes the following new features: 

a. Ticks Per Row – Allows you to combine price levels into a single row.  Four 

aggregation options are available: 

i. Up – rows are collected up to the next price level 

ii. Down – rows are collected down to the next price level 

iii. Offer Up/Bid Down – Offer rows are collected up, Bid rows are collected 

down 

iv. Round rows are rounded to the nearest price level. 

b. OCO Orders – OCO (One Cancels Other) can be places directly on the DOM 

using the new OCO selector in the tool bar. 

c. Order Connector Lines – OCO and child orders now have connector lines to 

make it easier to visual these relationships. 

d. LTQ – Last Trade Quantity can be displayed in the price column with an outline 

to show it the trade occurred at bid or at offer. 

e. Cross Trade – Cross trade is available in standalone DOMs 

f. Link Price – When attached to a chart the link price feature now works both 

when moving the chart or scrolling the DOM table. 

g. Bid/Ask Delta Column – New column that combines the Bid Delta and Ask 

Delta. 

h. Price Format – The price column can now be formatted to only show the last X 

digits 

i. Theoretical Average – Theoretical average for a position can now be displayed 

in the price column. 

2. Order Book – The Order Book has been rewritten and includes the following features: 

a. Ticks Per Row – Allows you to combine price levels into a single row.  Four 

aggregation options are available: 

i. Up – rows are collected up to the next price level 

ii. Down – rows are collected down to the next price level 

iii. Offer Up/Bid Down – Offer rows are collected up, Bid rows are collected 

down 

iv. Round rows are rounded to the nearest price level. 

b. Cumulative Volume – Displays a cumulative total of the volume for each row as 

a background on the table. 

c. Cross Trade – Cross trade is available in standalone Order Books 

3. Rithmic – Added environments for NeuroStreet and Bulenox 

4. Keyboard Shortcuts –  

a. Added a filter field to search for keyboard shortcuts (See General Preferences 

Dialog -> General -> Keyboard). 

b. Added shortcut to toggle Exit Strategy (power on/off) 



5. Volume Imprint Study 

a. HVN/LVN – Added support for High Volume Nodes / Low Volume Nodes (see 

new HVN/LVN tab. 

b. Gradient Contrast – Added a slider to adjust the contrast for color adjust 

gradient option (see Display tab). 

6. Trade Report – The Trade Report is now available in the Standard Edition. 

7. General  

a. Cancel Lease Button – If you have a recurring lease, you will see an option to 

cancel the lease from the Help -> About dialog. 

b. Max Linear/Non Linear Bars – Increased the maximum to 9,999,999 

Version 6.7.12 

This is a bug fix only release.  No new features have been added in this update. 

Version 6.7.11 

This is a bug fix only release.  No new features have been added in this update. 

Version 6.7.10 

This is a bug fix only release.  No new features have been added in this update. 

Version 6.7.9 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Support/Resist Component – Added an option to show top/bottom prices. 

2. TradeStation – Upgraded to V3 of the TradeStation API. 

 

Version 6.7.8 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Volume Imprint – Added the following options: 

a. Option to not print the volume using Thousands (K) and millions(M) 

formatting. 

 

Version 6.7.7 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Volume Imprint – Added the following options: 

a. Scale histogram by Bar, Visible Bars or Chart Session (ETH or RTH) 

b. Color histogram using Volume or Delta 

c. Optional reverse coloring for Gradient option 

Version 6.7.6 

This version of MotiveWave contains numerous bug fixes and the following features: 



1. FXCM – Updated to their latest Java API. 

2. IQFeed – Upgraded to the latest protocol 6.2.  This adds the following features: 

a. MBO – Market by order including individual orders and extra depth levels 

b. Aggressor Flags – Aggressor flags are used where available for determining 

atAsk/atBid values for live and historical Time/Sales data 

3. Java 20 – Upgraded to the latest Java runtime. 

 

Version 6.7.5 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Coinbase – Added support for Coinbase Advanced API.  This is a replacement for the 

current Coinbase Pro API which will be deprecated soon. 

Version 6.7.4 

This is a bug fix release only.  No new features are included in this update. 

Version 6.7.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Save Live Tick Data – For CQG and Rithmic, live incoming ticks (Time And Sales) can 

be saved to disk to avoid loading historical tick data from the server.  This feature can be 

disabled from the Preferences Dialog (Configure -> Preferences from the Console menu 

bar, see Historical Data tab). 

Version 6.7.2 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Chart Orders – Added an option to create (but not submit) an order.  By default this is 

disabled, but can be configured in the General Preferences Dialog (Configure -> 

Preferences, click on Orders then on Submission). 

Version 6.7.1 

This is a bug fix release only.  No new features are included in this update. 

Version 6.7.0 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Trade Copier – This feature enabled you to copy trades from a lead account to follower 

accounts.  Chooser File -> New -> Trade Copier Account from the Console Menu Bar. 

2. Chart Orders – The look and behavior of the chart orders has been updated in this 

release.  Submission and Display options can be found under the General Preferences 

Dialog (Configure -> Preferences from the Console Menu bar, see “Orders” tab). 

3. Binance Futures – Support for USD-M Futures and COIN-M Futures have been added.  

Note: this is a separate connection from the existing Binance (Spot/Margin) service.  

Note: you will need to make sure your API key has been enabled for futures. 

4. Kraken Futures – Kraken futures are now supported.  Note: this is a separate Kraken 



Futures connection from the existing Kraken Spot connection. 

5. IronBeam – connections for IronBeam via CQG and Rithmic have been added. 

6. Continuous Contracts – Another adjust method has been added: Cumulative Diff 

Adjusted.  This option will apply the sum of all contract differences ahead of the current 

contract instead of just the difference from the next contract. 

7. TPO Study – Added the following options: 

a. Merge/Split Eth Split Session – You can now merge/split TPOs that have the 

Split Reg vs Ext Session attribute. 

b. Display Tab – (Split Reg vs Ext session only) POC line can be displayed for 

ETH Only, RTH only or Both sessions 

c. Volume Profile Tab  

i. (Split Reg vs Ext session only) POC line can be displayed for ETH Only, 

RTH only or Both sessions 

ii. Added Naked POC option 

8. SDK – The following new classes were added: 

a. Info classes – These classes derive from BaseInfo and have an enabled attribute: 

i. BarSizeInfo 

ii. FileInfo 

iii. InputInfo 

iv. InstrInfo 

v. MAMethodInfo 

vi. StringInfo 

b. Desc classes - The following descriptor classes were added to supplement the 

above info classes: 

i. BarSizeDesc 

ii. DiscreteDesc – Works with StringInfo 

iii. FileDesc 

iv. InputDesc 

v. InstrDesc 

vi. MAMethodDesc 

 

Version 6.6.15 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Java – Updated to the latest version (19.0.2) 

2. Rithmic Connector – Added Funded Futures 

Version 6.6.14 

This is a bug fix release only.  No new features are included in this update. 

Version 6.6.13 

This is a bug fix release only.  No new features are included in this update. 



Version 6.6.12 

This update includes a fix for the Google/Yahoo data feed due to changes that Yahoo made over 

the weekend. 

Version 6.6.11 

This is a bug fix release only.  No new features are included in this update. 

Version 6.6.10 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Volume Imprint – Added filter options to the Delta column: Text, Color, Text and 

Color. 

2. Volume Imprint – Add Unfinished Auction lines and outlines.  See “Display” tab 

and “Bid/Ask”, “Delta”, “Volume” tabs for outlines. 

3. Java – Updated to the latest version (19.0.1) 

4. Rithmic – Added environments for Leeloo Trading and The Trading Pit 

 

Version 6.6.9 

This update includes a high priority fix for the Rithmic connector that includes a missing Paper 

Trading connection. No new features are included in this update. 

 

Version 6.6.8 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Java – Updated to the latest version of Java (18.0.2.1) 

2. Rithmic – Added numerous new environments to choose from including Apex, 

Natural Trading, Trade Fundrr, UProfit Trader.  Environments are now organized by 

System and Location in the login dialog. 

3. Import Trades – Added an option to import Trade History from a CSV file.  The 

CSV file must be generated by MotiveWave using the Export Trades option. 

 

Version 6.6.7 

This update includes a high priority fix for the Rithmic connector in addition to other fixes. No 

new features are included in this update. 

Version 6.6.5 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Java – Updated to the latest version of Java (18.0.1.1) 

2. Oanda – Updated login procedure to use a native browser instead of the built-in 

JavaFX web view. 



Version 6.6.4 

This update includes a high priority fix for the Google/Yahoo connector in addition to other 

fixes. No new features are included in this update. 

Version 6.6.3 

This is a bug fix release only.  No new features are included in this update. 

Version 6.6.2 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Rithmic – Updated to the latest Rithmic release (12.0.0) 

a. M1 Support – Rithmic will now work on the native M1 version. 

Version 6.6.1 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Rithmic – Updated to the latest Rithmic release (11.4.2) 

2. Cloud Levels – Added option to disable the filter for the current symbol. 

3. Zoom Bar Size – Added an override for this setting for a specific chart (See Chart 

Preferences, General panel) 

4. OHLC Study – Added options for Daily, Weekly, Monthly and Yearly OHLC values 

5. Big Trades – Added signal alerts for trades that occur above minimum sizes 

6. TPO Study – Added Single Prints 

7. Volume Imprint – The following enhancements have been added to Volume Imprint 

a. Summary Profile – Added option to align on left side 

b. Added alerts for totals: 

i. Volume 

ii. Delta 

iii. Delta Change 

iv. Cumulative Delta 

v. AVAP 

Version 6.6.0 

This version of MotiveWave contains numerous bug fixes and the following features: 

9. Java/JavaFX 17.0.2 – Updated to the latest Java/JavaFX version 

10. Mac OS M1 – M1 native version now available.  Note: Rithmic is not supported in this 

version.  We are still waiting for native libraries from Rithmic. 

11. Cumulative Delta – Added the following options to the Cumulative Delta study: 

a. Up/@Bid, Down/@Ask Color – Optionally this will color the bar with the given 

color where the bar close > open and bar delta < 0 or bar close < open and bar 

delta > 0 

b. Auto Scale – If this option is selected scaling of the graph will not include the 

zero line 

12. Delta Volume – Added the following option: 

a. Up/@Bid, Down/@Ask Color – Optionally this will color the bar with the given 



color where the bar close > open and bar delta < 0 or bar close < open and bar 

delta > 0 

13. OHLC Study – Added “Shorten Latest” option to display the latest print values closer to 

the latest candle. 

14. Table Grid – Table grid options have been added to the DOM, Time and Sales Panel and 

the Order Book: 

a. Grid Color – Ability to choose the grid color 

b. Vertical Width – Set the width of the vertical lines (0 to hide) 

c. Horizontal Width - Set the width of horizontal lines (0 to hide) 

15. DOM Enhancements 

a. Text Color/Text Align – Ability to choose a different text color and alignment 

for most columns 

b. Delta Reset Interval – Added a reset interval for calculating the bid/ask delta 

columns.  By default, it will not reset. 

c. Delta Max Levels – The number of bid/ask delta levels can be limited (20/side by 

default) 

16. Time And Sales – Updated the layout of the Time and Sales Preferences dialog. 

a. Above Ask/Below Bid – Added coloring options for Time and Sale rows where 

the price traded above the ask or below the bid 

b. Font – customized fonts can be chosen for @Ask, @Bid, Above Ask, Below Bid 

and highlighted sizes 

17. Replay Mode – Added a speed control to the replay bar.  This will allow you to adjust 

the replay speed dynamically.  Note: this control is only visible if “Real Delay” is turned 

on in the Preferences dialog. 

18. Volume Profile/TPO – Added an option compute the Value Area using Standard vs 

Optimized methods (see Configure -> Preferences from the Console menu bar, General 

Panel, Value Area Method setting): 

a. Standard – Start with the POC, then look 2 rows above and below and add the 

set with the larger volume (similar to most trading platforms) 

b. Optimized – Computes the optimal Value Area that has the smallest number of 

rows.  Note: this can be much more CPU intensive 

19. VWAP – Paths are now drawn separately between periods instead of continuous.  For 

example on a daily VWAP, the lines will restart at the beginning of the day making it 

easier to see the starting point. 

 

Version 6.5.12 

This is a bug fix release only.  No new features are included in this update. 

Version 6.5.11 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. VRAM Settings – Added an option to adjust the VRAM settings in the Advanced 

Startup options. 

2. Java 17.0.1 – Updated to the latest Java and JavaFX runtime 



Version 6.5.10 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Java 17 – Updated to the latest Java/Java FX runtime (JDK-17). 

2. BTC/ETH Futures – added support for Bitcoin/Micro Bitcoin and Ether Futures.  

Includes cross trading for BTC – MBT. 

 

Version 6.5.9 

This is a bug fix release only.  No new features are included in this update. 

Version 6.5.8 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. CQG Connector – Updated to the latest CQG connector protocol (2.32). 

2. SDK – Added two methods to specify the minimum number of bars for a specific bar 

size: 

a. Study::getMinBars(DataContext ctx, BarSize bs) 

b. Study::setMinBars(int bars, BarSize bs) 

 

Version 6.5.7 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Attach Exit Strategy – Added an option to create a keyboard shortcut to attach the 

active Exit Strategy to an open position. 

2. Volume Profile Study – Added an “Offset” parameter to offset the profile X pixels from 

the left or right side of the price graph 

3. Show/Hide Studies – Added two new actions to show/hide all studies and show/hide 

study graphs.  See View -> Display -> Show Studies and View -> Display -> Show 

Study Graphs 

4. Focus Quick Search – Shift + Esc will now switch the keyboard focus to the Quick 

Search box.  The keyboard short cut can be configured under Preferences Dialog 

(General -> Keyboard) 

Version 6.5.6 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Cross Trade – Added support for Micro Crude Futures Contract.  Cross trade on CL 

will now trade with the Micro contract instead of the e-mini contract. 

2. dxFeed – added support for EUREX, EDGX 

3. IQFeed/IB – Improved symbol mapping for IQFeed – Interactive brokers for futures 

contracts. 

Version 6.5.5 

This version of MotiveWave contains numerous bug fixes and the following features: 



1. Order Heatmap – Performance and memory improvements 

2. CME Equity Trading Hours – Updated the trading hours for CME equities to remove 

the 3:15-3:30 session 

Version 6.5.4 

This is a bug fix only release.  No new features are included in this update. 

Version 6.5.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. dxFeed – Added support for dxFeed data service: 
https://get.dxfeed.com/orders/new/motivewave 

2. Order History – This study displays a visual history of order placement, modifications 

cancels and fills on the chart.  Choose Study -> All Studies (from the top menu bar) and 

search for “Order History”. 

3. Settlement Price – The settlement price can now be displayed: 

a. Price Indicator – as a price indicator on the price graph  

b. Chart Label – as a label on the chart 

c. DOM Price Column – highlighted in the price column of the DOM 

4. Cross Trade – Added cross trade options for the following (CQG and Rithmic only) 

a. DAX Index -> Micro Dax Index 

b. Euro STOXX 50 -> Micro Euro STOXX 50  

5. Volume Imprint – Added an option to show the summary profile as a specific number of 

minutes or days 

6. Fractal – Added “Alternate High/Low” option.  This will alternate printing high 

markers with low markers 

 

Version 6.5.2 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Path/Price Bar Tag – An option tag may be displayed to the right of path for most 

studies (see advanced properties for a study path). 

2. Cumulative Delta –  

a. Max Bottom/Min Top – These options set a minimum/maximum value for the 

top/bottom axis 

b. Relative Delta – Plots additional cumulative delta bars that may be filtered by the 

tick size.  Up to 4 plots. 

3. VWAP – Added option to plot Regular Session, Extended session or the session chosen 

for the chart. 

4. DOM –  

a. Opening Range - Added Opening Range option to display the opening range on 

the price column 

b. Disable Recenter on Mouse Above Table – This option will disable the recenter 

option when the mouse is above the table. 

c. Buy Bid/Sell Ask – If this option is enabled only buy orders can be placed on the 

Bid column and only Sell orders can be placed on the Ask column. 

https://get.dxfeed.com/orders/new/motivewave


5. Zig Zag Osc - Added Zig Zag oscillator study.  This displays the Zig Zag study in a 

separate plot. 

6. OHLC Study – Added Overnight High/Low 

7. Trade Panel – Added option to hide the P/L label. 

8. Rithmic – Updated to the latest Rithmic Connector (11.1.0.0) 

Version 6.5.1 

This is a bug fix only release.  No new features are included in this update. 

Version 6.5.0 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Zoom Bar Width – Adjustments to the bar width smaller 1 pixel wide will automatically 

adjust the bar size (linear bars only).  For example, if the bar size is 1 minute, reducing 

the bar width (from 1 pixel) will switch the bar size to 2 min, 4 min, 8 min etc.  

Expanding the bar width from that state will revert the bar size to 4 min, 2 min and then 1 

minute. 

2. OHLC Developing Mid/High/Low – Options have been added to show the developing 

Midpoint, High and Low values. 

3. DOM- The following options have been added to the DOM: 

a. Show Order Brackets – Before an order is placed from the DOM, the cells in the 

Order column will display where the entry and exit orders will be placed along 

with their quantities.  You can turn this feature off in the DOM Preferences (see 

General panel, “Show Order Brackets”) 

b. Highlight Price Row – The entire row can now be highlighted for the last price 

(see Price Column tab in the DOM Preferences dialog). 

4. Exit Strategy Orders – Placeholder orders will now be displayed for the exit orders that 

will be generated when an entry order is filled. 

5. Volume Imprint Trade Dots – The Volume Imprint study has been enhanced to show 

large trades at the Bid/Ask on the left/right sides of the Imprint (see Trade Dots tab). 

6. Cloud Levels “Edit Mode” – The Cloud Levels study now has an edit mode (right click 

on the study header and choose “Edit Mode”).  This will allow you to edit the price 

levels and add/delete levels.  The changes can be saved to a CSV file via Right Click -> 

Save option 

7. VWAP Component – (Order Flow, Professional and Ultimate Editions only).  The 

VWAP component is available as a Mouse Tool or in the “General” tab of the 

Components Panel.  This behaves similar to the VWAP study, but has resize points to 

choose the Start/End points. 

8. Order Heatmap – Added an option to filter the maximum sizes.  This will filter out 

large sizes that can skew the heatmap colors. 

9. SDK – Additional methods added to the Study class to provide more interaction with the 

mouse: 

a. onDoubleClick() – Allows the study to respond to double click events 

b. onClick() – Respond to single click events 

c. onWheelMoved() – Respond to mouse wheel events. 



Version 6.4.7 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Profit/Loss Components – Added right click options to Flip, and change the number of 

targets. 

2. Time&Sales 

a. @Bid/@Ask Background – Added an option to set the background (in addition 

to text color) 

b. Highlight Big Sizes – Added an option to highlight the size cell only 

c. Price Format – Added options for displaying only part of the price 

d. Time Format – Added options for formatting the time column 

3. Shift Wheel Action – Added an option to change the behavior of holding down the shift 

key when using the mouse wheel.  By default this will adjust the vertical spacing. 

Version 6.4.6 

This is a bug fix only release.  No new features are included in this update. 

Version 6.4.5 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Order Heatmap – Added an option to scale visible rows only.  This will apply the color 

map to the sizes that are visible only. 

2. DOM Templates – Added the ability to import and export DOM templates 

3. DOM / Time & Sales /Order Book - Holding down the CTRL (CMD on Mac) key 

while scrolling the mouse wheel will change the row height of the table.  This will allow 

you to zoom in/out. 

4. DOM Recenter – Double click on the DOM table will recenter.  Holding down the 

control key will recenter all DOMs  

5. Cumulative Delta – Added options to change the color above/below 0 for a line chart 

(see advanced properties, Color Policy option) 

6. Zig Zag – Added option for reversal in ticks. 

 

Version 6.4.4 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Cross Trading – Cross trading futures contracts can be done via right click on the chart 

and choose: Cross Trade (symbol).  For example, you can trade the MES contract from 

an ES chart. 

2. Stacked Orders  

a. DOM – Orders at the same price will be displayed with brackets [].  The quantity 

displayed will be the sum of all the orders.  The position in queue marker will 

also display multiple markers.   

b. Price Graph – Orders that overlap will be offset to show that multiple exist and 

you can click drag any of the orders. 

3. Drag Stacked Orders – Holding on the control key (command on Mac) while dragging 

an order in the DOM or price graph will modify all orders of the same type and price.   



4. Rithmic – Support for delayed accounts 

5. Java 16 – Updated to the latest version of Java/JavaFX 

 

Version 6.4.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. DOM Panel   

a. Price Column – Added Alignment and option to display cumulative trades (same 

as Last Trade Quantity Column) 

b. Table Striping – Added option to turn off the striping of the table rows 

2. Time/Sales and Order Book – Added option to turn off striping of the table rows 

3. Erase Chart Shortcut – Added Erase option to the mouse shortcuts for the chart.  This 

shortcut would allow you to use a keyboard modifier to erase chart elements with a 

mouse click. 

4. Fractal Study – Added a “Show Label” option to display the price of the high/low 

 

Version 6.4.2 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. DOM Panel   

a. Orders 

i. Right Click – Added access to order combinations (Limit + Stop/Limit 

etc) via a right click menu on the DOM Table 

ii. Configurable Mouse Orders – The behavior of placing orders directly on 

the DOM table may now be configured to place order combinations.  

Additionally, keyboard modifiers (Shift, Ctrl, Ctrl+Shift) may be used to 

setup multiple order types/combinations.  (See DOM Preferences, 

General tab) 

b. LTQ Column – this column can be configured to highlight the background of the 

cell when the trade occurred at the bid or ask. 

c. Table Font – The font used for the table cells is now configurable from the DOM 

Preferences dialog. 

d. Row Height – A fixed row height can be set for the table 

2. Time and Sales Panel 

a. Table Font – The font used for the table cells is now configurable from the 

Time/Sales Preferences Dialog 

b. Row Height – A fixed row height can be set for the table 

c. Min Width – The minimum width of this panel has been reduced to 175 px. 

3. Order Book Panel 

a. Table Font – The font used for the table cells is now configurable from the 

Time/Sales Preferences Dialog 

b. Row Height – A fixed row height can be set for the table 

4. Ruler Tool – Added an option to make the Ruler stick to the chart after its drawn.  This 

effectively adds it as a component to the chart.  See Preferences Dialog (Configure -> 

Preferences from the Console Menu bar), Chart -> Options tab.  Erase Ruler option. 



5. Hide Account Name – The account name can be obfuscated in all the MotiveWave 

screens and display as “XXXXXX857” (for example).  See Preferences Dialog -> 

General Panel. 

6. VWAP – Multiple VWAP studies using the same criteria can now be added to the chart 

with different anchor points.  Note: they must have different colored/styled lines. 

Version 6.4.1 

This is a bug fix only release.  No new features are included in this update. 

Version 6.4.0 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Chart Indicators – The following enhancements have been added to the Chart 

Indicators: 

a. Chart Specific Settings – Charts can override the global settings from the Chart 

Preferences Dialog (double click on the chart, see “Indicators” tab). 

b. Avg Entry Price – This new indicator displays the average entry price for the 

current position as an indicator. 

c. Tags – optionally a tag may be assigned to an indicator.  This tag displays the 

given text to the left of the indicator. 

2. Time Axis – The following enhancements have been added to the Time Axis: 

a. Chart Specific Settings – Charts can override the global settings from the Chart 

Preferences Dialog (double click on the chart, see “Time Axis” tab). 

b. Line Color – a color can now be chosen for each time axis line that is enabled 

c. Time of Day – custom lines can be displayed at specific times of the day (ie: 

11:00 AM). 

3. Trading Hours – The following enhancements have been added to the Trading Hours 

feature (see General Preferences Dialog, General -> Trading Hours tab): 

a. Hours – the interface for specifying trading hours has been simplified to provide 

the same daily hours across multiple days (ie Monday – Friday, Sunday – 

Saturday etc) 

b. Edit Built-In Hours – The built-in hours can now be modified instead of creating 

a new set of trading hours.  You can revert to the default hours by selecting the 

modified hours in the list and pressing the “Delete” key. 

c. Multiple Exchanges – You can assign trading hours to multiple exchange. 

d. Intraday Bar – You can specify a bar build method for intraday bars (overriding 

the global default).  See Intraday Bars tab in the Trading Hours dialog. 

4. Default Layout – The default layout has changed when creating a new workspace. 

5. Watch List Notes – A “Notes” column has been added to the Watch Lists where you can 

enter custom notes.  Clicking on the cell in the watch list will allow you to edit the value 

inline. 

6. Popout Panels – A popout option has been more of the panels in the console: Accounts, 

Positions, Orders, Trades, Optimizer, Alerts, Trade Report, Options, Journal. 

7. Sim Trade Only – An option has been added to the built-in simulated account to only 

allow trading on the internal sim account.  See Preferences Dialog (Configure -> 

Preferences from the Console menu bar.  Click on “General” and then on “Simulated 



Account”). 

8. Intraday Bar Build – The method for configuring how intraday bars are built can not be 

set per instrument or per Trading Hours (see above). 

9. Miscellaneous Features 

a. Export Trades – now includes milliseconds 

b. Alerts – Comments are now displayed in the alerts and alert history panels 

c. OHLC Study – Added previous open 

d. Labelled Line – Price can be chosen in the properties dialog 

e. Study Graph – Ability to remove the display of the study title (see Options tab 

“Show Legend”) 

f. Exit Strategy – Added decimal places for stop/target where the offset type is 

“Percent” 

g. Quick Search – Auto complete feature can be turned off 

h. Volume Imprint – Horizontal offset can be added to the Summary Profile 

i. TPO Study – Volume profiles now have an option align (left or right) 

j. Mid Point – Added midpoint column to watch lists.  This is the midpoint 

between the bid/ask prices 

Version 6.3.4 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. TDA – Order Book has an added option to expand the rows by Market Maker and 

optionally color rows at the same price 

2. Time Calculation Method – Added an option to calculate elapsed time in a component 

using Elapsed time vs Trading time.  This option is available in the Preferences dialog 

(Configure -> Preferences from the top menu bar, see Chart -> Chart Settings) 

3. Time Sales – Added an optional end time field.  This allows to you scroll to a specific 

time in the Time and Sales panel.  (See Time and Sales Preferences Dialog).  

 

Version 6.3.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Interactive Brokers Smart Depth – Order Book has an added option to expand the rows 

by Market Maker and optionally color rows at the same price 

Version 6.3.2 

 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Interactive Brokers Smart Depth – Upgraded to the latest TWS API and added support 

for SMART depth for stocks 

2. CQG – Updated to the latest CQG API 

3. Cumulative Delta – Added the ability to restart delta calculation at start of week or start 

of month. 

4. Trade History – Added the option to choose account on Export to CSV feature. 

5. DOM shortcuts – Added the ability to assign keyboard shortcuts to the following 

actions: 



a. Reset @Bid/@Ask 

b. Lock DOM 

c. Clear Notes 

6. DOM Price Scaling – The scaling of the price ladder in the DOM can now be synced 

with the price graph. A new button has been added to the tool bar in the DOM to toggle 

this feature on /off.  

7. LTQ DOM Column – Added a column to the DOM for computing last traded quantity. 

Version 6.3.1 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Study Quick Editor/Tool Bar – Study controls can now be added to the tool bar and are 

accessible from a new Quick Editor on the chart. 

a. Quick Editor – buttons have been added to the study titles to show a Quick 

Editor that contains study controls 

b. Tool Bar – A “Tool Bar” tab has been added to the study dialog to choose 

controls that are displayed in the tool bar. 

c. Tool Bar Study Editor – A “Study Editor” action is available to add to the tool 

bar.  This is used in conjunction with the Tool Bar option above and will display 

the selected controls.  (See Preferences Dialog, “Tool Bar” tab). 

2. SDK – The SDK has been enhanced to specific settings that are available to the Quick 

Editor and tool bar.  For details see the updated SDK document: 

https://www.motivewave.com/support/sdk.htm 

 

Version 6.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Rithmic 10.16 – Updated to the latest Rithmic library.  This update includes significant 

updates to the performance of loading historical tick data. 

2. Order Heatmap – This new study replaces the existing DOM History study.  This has 

the following changes: 

a. Gradient Color Control - a single color control that allows you to select multiple 

colors to use as a gradient for categorizing the relative totals of orders in the 

DOM at each price.   

b. Contrast – This option allows you to hide levels that have totals below a specific 

percentage of the highest value 

c. Opacity – Changes the opacity of all the bands 

d. Lines – optionally displays divider lines between the banks 

3. Big Trades – Added an “Auto Circle” option to adjust the size of the circle based on the 

trade size.  Larger trades will appear with a larger circle. 

4. Millisecond Bars – Bar sizes can now be specified in milliseconds (min 20 ms) 

5. Auto Move Bar – If enabled, this option will automatically create the next bar when the 

time has elapsed (instead of waiting for the next bar).  This is especially useful for 

Millisecond bars (see above) to show a continuously moving chart (See Preferences 

Dialog, Configure -> Preferences from the Console menu bar.  Click on “Chart” then on 

“Options”) 



6. Line Chart Label – Allows you to change the label displayed to the right of a line chart.  

Options are: None, Price and Symbol.  This is available from the Chart Settings dialog 

(right click on the chart and choose “Chart Settings”). 

7. Trade Report – Generates a report (similar to the report in the Optimizer) for an 

account.  This option also works for replay mode.  A Trade Report tab can be added by 

clicking on the ‘+’ button to the right of a chart tab. 

8. Zytrade – Added a new broker connection for Zytrade (Futures and Future options, 

connects via Rithmic). 

9. Java/JavaFX 15 – Updated to the latest Java and JavaFX 15.0.1 

10. Cloud Levels Study – Display price levels that can be loaded from a local file or from a 

website.  Supported formats include BookMap and IRT CSV files. 

11. Price Bar Types – Square line charts have been added.  These are similar to the line 

charts, but only draws horizontal and vertical lines (no diagonals): 

a. Square Line 

b. Square Line (Shaded) 

c. Square Line (Gradient) 

Version 6.2.5 

This is a bug fix only release.  No new features are included in this update. 

Version 6.2.4 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Futures Roll Options – Added support for additional roll options and added defaults 

for major futures contracts: 

a. Days Before Start of Contract Month 

b. Days Before Day of Week Before Contract Month 

c. Days Before Day of Month Before Contract Month 

d. Days Before 1st Business Day of Contract Month 

e. Days After Start of Contract Month 

f. Days Before Day of Week 

g. Days Before Day of Month 

h. Days Before End of Contract Month 

i. Days Before Last Business Day of Contract Month 

2. Active Contract – Added the ability to show the active contract for a Continuous 

Future in the Quote Board and Buy/Sell Boxes.  See Preferences Dialog (Configure 

-> Preferences from the Console menu bar.  Click on “Buy/Sell” tab). 

3. Trade Manager Strategy – Added the ability to specify Ticks or Pips when 

calculating offsets. 

Version 6.2.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Continuous Futures – Added support for custom continuous futures contracts that 

automatically roll based on volume or expiry date.  Choose File -> New -> 

Continuous Future from the Console menu bar. 

2. Active Contract – The active contract for a continuous future (see feature above) can 



be displayed in two locations: 

a. Chart Label – A new chart label has been created for this.  See Chart 

Settings -> Labels tab 

b. Watch List – a new Column “Active Contract” has been added to the Watch 

List/Quote Sheets. 

 

Version 6.2.2 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Kraken – Added support for Kraken crypto exchange 

2. Coinbase Pro – Added support for Coinbase Pro exchange 

3. Binance – Added support for Cross Margin Accounts 

4. JavaFX 14.0.2.1 – Updated to the latest JavaFX version 

5. Questrade – Removed support for Questrade 

6. Rithmic – The following enhancements were added to the Rithmic connector 

a. Added the following environments: 

i. Rithmic 04 Colo 

ii. Rithmic 04 Aurora 

iii. Speedup 

b. Exchange Order ID – Added aggressor and resting exchange order ids to the 

live tick data. 

7. Time & Sales Panel – Added option to “Aggregate by Order” (using new Rithmic 

feature above).  If enabled time & sales entries will be combined if the aggressor 

exchange Order Ids and price match.  This applies to consecutive trades only. 

8. Big Trades – Added “Aggregate by Order” option (see above). 

9. OHLC Study – Added support for specifying seconds for the opening range 

 

Version 6.2.1 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Binance – Added support for Binance crypto exchange 

2. Quote Board – This is a new view for a Watch List/Quote Sheet (in addition to table 

and Buy/Sell boxes).  You can change a watch list to display a quote board by 

choosing “Quote Board” in the drop down in the watch list tool bar. 

3. Java 14.0.2 – Updated to the latest Java version 

Version 6.2 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Community Edition – New Free Edition of MotiveWave 

2. CryptoCompare – Added support the latest web socket API.  Also added support 

for the Order Book (Level 2 data). 



Version 6.1.17 

This is a bug fix only release.  No new features are included in this update.  

Version 6.1.16 

This is a bug fix only release.  No new features are included in this update.  

Version 6.1.15 

This is a bug fix only release.  No new features are included in this update.  

Version 6.1.14 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Performance Improvements – Added some additional performance tweaks. 

2. Order Flow Edition – The Trade Edition has been renamed to the Order Flow 

Edition.  We also added the following features (previously only available in 

Professional and above): 

a. Volume Profile Component (see General Component tab) 

b. TPO Component (see General Component tab) 

3. Standard/Elliott Wave Lite Editions –Trading capability has been added to these 

editions, this includes the following: 

a. Live and Simulated Trading 

b. Account/Orders/Positions/Trade History Panels 

c. Trade Panel 

d. Time and Sales Panel 

e. Depth of Market – Note this is a basic DOM and does not include all of the 

features in the advanced DOM available in the Order Flow Edition and above 

f. Order Book Panel 

4. Show Roll Dates – Added options to show optional top and/or bottom markers for 

roll dates on the chart 

5. Instrument Graph Study -Added an option fixed range 

6. Java 14.01 -Updated to the latest Java version 

7. Rithmic - Updated to the latest Rithmic API (10.10.1.0). 

 

Version 6.1.13 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Performance Improvements – Some significant changes have been made to improve 

the performance of MotiveWave with high volumes of live market data. 

2. Watch List -Added an option to replace a futures contract with the next contract.  Right 

click on a futures contract in the Watch List/Quote Sheet and choose “Replace with Next 



Contract” 

3. Roll Date Lines – For continuous contracts computed on the client side, lines can be 

displayed for the roll dates in the chart.  See Preferences Dialog (Configure -> 

Preferences, click on “Chart” then on “Time Axis”).  The dates can be configured per 

chart from the Chart Preferences Dialog (double click on the chart, see “Display” tab). 

4. Trend Line – a different line style can be chosen for the extended parts of a trend line. 

See Properties dialog (double click on the trend line, “Format” tab). 

Version 6.1.12 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Chart Specific Data Settings – Continuous contract options can now be applied to a 

specific chart overriding instrument and global settings.  See Chart Preferences Dialog 

-> “Data” tab. 

2. Export Pages – For floating layouts, specific stations can be chosen to be included in the 

export. 

3. Compute Change Using Settlement – A new option has been added to compute the 

daily change information using the settlement price instead of the previous close (futures 

only).  This can be configured in the Preferences dialog (Configure -> Preferences see 

General tab). 

4. Rithmic – Added additional environments and also added an option on login to choose 

Aggregated vs Non-Aggregated data. 

5. Java 14 – Updated to Java 14 

Version 6.1.11 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Google/Yahoo Connection – Updated the connector to reflect recent changes for loading 

historical data from Yahoo 

2. Continuous Contracts –Added a new option to compute continuous contracts using the 

expiry date (instead of roll over on volume). 

Version 6.1.10 

This update contains an important fix for BarChart historical data. 

No new features are included in this update. 

Version 6.1.9 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. BarChart – Added support for Crypto Currencies 

2. New Studies: 

a. McClellan Oscillator – compares moving averages on the difference between 

advancing and declining issues. 

b. McClellan Summation Index – Displays a rolling summation of the McClellan 

Oscillator 

c. Seasonality – Calculates the average gain/loss (as a percentage) from the start of 

year or month. This study only works in daily bars. 



Version 6.1.8 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. BarChart Continuous Contracts – Optionally continuous data for futures contracts can 

be computed in MotiveWave (using the same logic as in CQG).  This will allow you to 

choose the back adjust method.  This feature can be enabled from the Preferences Dialog 

(Configure -> Preferences from the console menu bar.  See Historical Data -> General). 

Version 6.1.7 

This update contains important fixes for issues introduced in 6.1.6. 

Version 6.1.6 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. BarChart – Updated to the latest BarChart streaming connector 

2. Max Heap/JVM Options – added advanced options to the startup screen to adjust the 

Maximum Heap Size and additional JVM options.  (Choose: Options -> Advanced from 

the startup splash screen) 

3. Windows – Removed MotiveWave (3GB) and MotiveWave (6GB) launch options.  

Larger heap sizes can be set above. 

4. Auto Update – The Auto Update feature has been changed in this version to download 

the MotiveWave installer and execute it after closing MotiveWave.  This feature will 

also work on the Mac as well (instead of having to manually download and install). 

5. Linux – Support for Linux distributions (Debian Package Format): 

a. Ubuntu – 18.04, 19.10 

b. Mint – 19.3 

c. Kubuntu – 19.10 

Version 6.1.5 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Snap to Grid – Floating dock stations can be snapped to the grid when dragging the 

mouse.  This feature can be enabled/disabled in the Preferences dialog (Configure -> 

Preferences from the console menu bar.  See General > Dock) 

2. Elliott Wave – The following enhancements have been added to the Elliott Wave 

features (see Preferences Dialog: Elliott Wave > General tab) 

a. Label Inset – optionally, spacing can be added between the wave label and the 

top/bottom of the price bar.  

b. Draw Lines From Last Bar – If enabled wave lines will be drawn from the last 

(latest) price bar instead for the entire wave. 

3. Java Runtime – Updated Java runtime to 13.0.2 

4. Mac Install – Switch from a .dmg to a .pkg for the Mac installer 

5. Memory Gauge – A gauge has been added to the right side of the status bar (Console 

and Desktops) that displays the current memory usage of the application. 

6. IQFeed Filter NTRF – Added an option to filter trades from the NTRF exchange for 

stocks.  See Preferences Dialog > General Panel 



Version 6.1.4 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. CQG – The following changes have been done for CQG: 

a. Latest Protocol – Updated to the latest CQG Continuum Protocol 

b. Balances – Balances are now available in the Balances panel (click on the ‘+’ 

button next to a dock tab and choose “Balances”) 

2. Global Data Feeds – Updated the port number for the data server 

 

Version 6.1.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Bitstamp – Added support for Crypto Broker Bitstamp: https://www.bitstamp.net 

2. Order Book – Added an Order Book option.  This is similar to a DOM, but displays the 

Bid and Ask orders in separate tables (horizontally instead of vertically in a DOM) 

3. BarChart – Added “Use Continuous Data” option (See Instrument Dialog -> Advanced 

Tab).  This option is on by default for all new instruments and will display continuous 

historical data for futures. 

Version 6.1.2 

This is a bug fix only release.  No new features are included in this update.  

Version 6.1.1 

This is a bug fix only release.  No new features are included in this update.  

Version 6.1 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Untitled Analyses – By default, MotiveWave will open a new Untitled Analysis when a 

chart is opened.  The contents of this analysis is local to the chart and is not synched 

between other charts.  An untitled analysis can be saved as a regular analysis by clicking 

the Save As button.  For details on analyses in MotiveWave see: 

https://www.motivewave.com/guides/MotiveWave_Analyses.pdf 

2. New Studies- The following studies have been added in this update: 

a. Bressert DSS 

b. RMO (Rahul Mohinder Oscillator) 

c. MA Ribbon 

3. Export/Import Pages – This feature allows you to export specific pages from the 

Console or Desktops.  These pages can be imported to another instance of MotiveWave 

using the Import Page option (See File -> Import/Export Pages from the top menu bar).  

Pages can also be setup to export on a schedule.  See Preferences Dialog (Configure -> 

Preferences from the Console menu bar.  Click on “General” then “Backup” then “Auto 

Export Pages”) 

https://www.bitstamp.net/
https://www.motivewave.com/guides/MotiveWave_Analyses.pdf


4. Floating Grid Background – This option (on by default) shows a grid background on 

Floating layouts.  Configuration options can be found in the Preferences Dialog 

(Configure -> Preferences from the Console menu bar.  Click on “General” the on 

“Dock”). 

Version 6.0.8 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Labelled Line – This new component draws a horizontal line with a customizable label 

attached to it.  This component can be found in the “General” stencil (see Components 

Panel). 

2. Visibility Options – You can now add multiple visibility options to a component, study 

or wave/time ratio.  An object is visible when one of the visibility conditions is met. 

3. Alert Conditions – Multiple alert conditions are now allowed when creating/modifying 

an alert. 

4. Indicator “Draw on Top” – Added an option to draw an indicator on top of the other 

indicators.  This is on by default for Bid, Ask and Last price.  This feature is also 

available for study indicators (see advanced properties). 

Version 6.0.7 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. NT Renko Bars – This specialized version of Renko bars starts the next bar at the 

midpoint of the previous bar (instead of at the top/bottom of the previous bar).  This bar 

type was developed by Newbie-Trader: https://www.newbie-trader.com/ 

2. Elliott Wave Preferences – The following options have been added the Elliott Waves. 

See Preferences dialog “Elliott Wave” tab and the Component Properties dialog (double 

click on the wave): 

a. Show Origin – If unchecked, the origin point will not be shown (even if it is the 

top-level wave) 

b. No Future Points – If checked, none of the future points will be displayed.  This 

is in contrast to the Show Future Points being unchecked where only the first 

future point is displayed. 

3. Commentary Components – The text for comments can now be modified in the 

component properties dialogs (right click and choose “Properties” from the comment).  

Additionally, changing this text as part of a custom component/tool will change the 

default text when the component is created. 

Version 6.0.6 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Save As Image Name – A new chart option “Use Last Image Name” (default off) has 

been added to the Chart Options panel (Configure -> Preferences from the Console menu 

bar, Chart -> Options).  If this option is enabled the last Save As Image file name will 

be used the next time you save the chart as an image (instead of generating the file name 

with the lastest timestamp). 

2. Data Export – Historical data can now be exported automatically and arranged in 

groups.  For details, see the Preferences Dialog (Configure -> Preferences from the 

https://www.newbie-trader.com/


Console menu) Click on “Historical Data” then on “Data Export”.  For details see: 

https://support.motivewave.com/knowledge-base/data-export-groups/ 

 

Version 6.0.5 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Floating Stations – A new layout has been added to the docking framework to manage 

floating stations (instead of using the split layout).  For details see the Docking 

Framework guide: 

https://www.motivewave.com/guides/MotiveWave_Docking_Framework.pdf 

Version 6.0.4 

This is a bug fix only release.  No new features are included in this update.  

Version 6.0.3 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. TDA Login – The login procedure has been changed to use a browser-based login. 

2. DOM Bid Ask Scaling – Three additional options have been added for scaling the 

histogram for the bid/ask columns: 

a. Fixed Max Size – Sets the maximum size for the bid/ask columns to a fixed 

value. 

b. Max Scale Size – Sets an upper limit on the max bid/ask sizes. Use this to lessen 

the effects of unusually large bid/ask values 

c. Scale Visible Rows Only – If enabled the scaling will be based on the max values 

for the visible rows only (instead of all DOM rows) 

3. DOM Bid/Ask Column – Added an additional column that combines the bid/ask sizes 

into a single column 

4. DOM Orders Column - Added the following enhancements to the DOM Order Column: 

a. Auto Hide Cancel – The cancel button is only shown when the cursor hovers 

above the order 

b. Context Menu – The context menu (right click) shows pre-set quantities for 

quickly modifying the order quantity. 

Version 6.0.2 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Java 13 – Updated to the latest Java VM.  This will require a full install on Windows 

(ie: download the latest installer from our website and run it on your local machine). 

https://support.motivewave.com/knowledge-base/data-export-groups/
https://www.motivewave.com/guides/MotiveWave_Docking_Framework.pdf


Version 6.0.1 

This is a bug fix only release.  No new features are included in this update.  

Version 6.0.0 

Version 6 has significant feature enhancements from version 5.  For a comprehensive 

explanation of all the changes please see: 

 

https://www.motivewave.com/guides/Whats_New_In_Version_6.pdf 

Version 6 Beta 3K 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Center All DOMs – This new option will center all Depth of Market panels when the 

re-center button is pressed (See DOM Preferences, General Panel).  For convenience a 

Keyboard Shortcut can also be assigned (see General Preferences Dialog, “General” -> 

“Keyboard” tab). 

2. IQFeed Odd Lot Ticks – This option will enable “Odd Lot Ticks” to be visible in 

MotiveWave for IQFeed symbols (off by default).  See General Preferences Dialog 

(Configure -> Preferences from the Console menu bar) -> “General” tab. 

Version 6 Beta 3J 

This is a bug fix only release.  No new features are included in this update.  

Version 6 Beta 3I 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Drag beyond available data – The chart can now be dragged beyond the available data 

leaving blank space on the left side of the chart. 

Version 6 Beta 3H 

This is a bug fix only release.  No new features are included in this update.  

Version 6 Beta 3G 

This version of MotiveWave contains numerous bug fixes and the following features: 

22. Updated Window Themes – The dark and light themes have been updated to remove 

station borders and present a flatter look and feel 

23. StockWatch Connector – This this data service connector has been removed in this 

update since they no longer support third party applications. 

24. TPO Study – The following enhancements have been added to the TPO study: 

a. Constrain Width – If this option is checked it will automatically reduce the cell 

https://www.motivewave.com/guides/Whats_New_In_Version_6.pdf


width if the profile overlaps the next profile. 

b. Align Letters per TPO – The align letters option may be enabled per TPO figure 

via the right click menu (right click on a TPO and choose “Align Letters”) 

c.  

25. Active Chart Tab Color – The color of the dock bar/tabs for active charts can be 

customized in the Preferences dialog (see “Theme” -> “Theme”, “Active Chart Tab 

Color) 

26. Time & Sales Text Color – The text color for the Time & Sales panel can now be 

configured from the TS Preferences dialog (click on the Gear icon) 

27. Cancel Existing Orders – An option has been added to cancel existing orders on the 

same account before executing a button action.  This applies to the following custom 

buttons in the Trade Panel/DOM: Break Even, Flatten and Reverse 

Version 6 Beta 3F 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Time Axis Spacing – Minimum spacing for major times displayed on the time axis has 

been added (default 100 pixels).  This option can be configured in the Preferences dialog 

(Configure -> Preferences from the console menu bar, click on Chart then on Time 

Axis). 

2. Extended vs Regular Bar Scheme – A new bar scheme has been added to color the 

extended and regular trading hours bars differently. 

3. VWAP Study – the following enhancements/changes have been added to the VWAP 

study: 

a. Std Dev Calculation – The calculation for the standard deviation has changed.  

It is now calculating using the difference between the HLC3 – VWAP (instead of 

the VWAP alone) 

b. Std Dev Bands – Up to 3 band lines can be configured  

c. Anchored VWAP – The starting point can be set for calculating the VWAP via 

right click (see menu options below): 

i. Remove Anchor – This option will remove a previously set anchor 

ii. Anchor VWAP at <Time> - This will set the anchor at the given time. 

4. Alert Close Position – An option has been added to close an open position when an alert 

is triggered (see Trade tab of the Alert Dialog). 

5. Study Indicator Tags – Descriptive tags can optionally be displayed next to the 

indicators displayed in the vertical axis.  Edit the advanced indicator settings (click on 

the edit button next to an indicator in the study dialog) and check the “Show Tag” box. 

Version 6 Beta 3E 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. TPO Study Align Letters – This option (see Display tab, Align Letters in Same 

Column check box) will place each letter in a separate column to better represent the 

time when that cell occurred. 

2. Reversal Bars – This new bar type has been added that has the following parameters: 

a. Reversal Amount – price movement in ticks from the high or low of the bar for 

the bar to complete.  The bar is considered complete when the close has reversed 



from the high/low by an amount equal or greater than this amount.  Reversal bars 

alternate between reversing from the high and low (ie if one bar reverses from the 

high, the next bar will reverse from the low) 

b. Minimum Amount – Minimum range for the bar (high – low) before the reversal 

amount is applied 

3. Relative Volume – This new study compares the volume on the current bar to the 

average volume for that same bar (same time of day) for the given period (see Study -> 

Volume -> Relative Volume). 

4. VWAP Study – Added top and bottom standard deviation lines (optional) 

5. EW Marker Tools – Added mouse tools for the Elliott Wave markers 

6. Move Copyright – The copyright message can be moved or hidden on specific chart via 

the right click menu: Move Copyright -> Location 

7. JPG image format removed – In the Save As Image dialog, the JPG image format has 

been removed since it is not supported by the Open JDK. 

8. Display Bars – The display bars setting can now be set individually for the chart.  See 

chart settings “General” tab. 

9. Bar Theme Price Line – The ability to change the price line for a custom bar theme has 

been added (when displaying a line chart vs a bar chart). 

10. Table Row Colors – The even and odd row colors for table elements can be customized 

from the Preferences Dialog (Configure -> Preferences from the console menu bar, click 

on Theme.  See option: Table Row Colors).  Note: a restart of MotiveWave is required 

to see the changed values. 

11. Time Axis Lines – Major vertical lines displayed from the time axis can be configured 

from the Preferences Dialog (Configure -> Preferences from the console menu bar.  

Click on “Chart” then on “Time Axis”).  The following lines may be configured 

a. Midnight – midnight using the time zone set for the chart. 

b. Start of Day ETH - Start of the day for extended trading hours (enabled by 

default). 

c. Start of Day RTH – Start of day for regular trading hours 

d. End of Day ETH – End of day for extended trading hours 

e. End of Day RTH – End of Day for regular trading hours 

f. Start of Week – Start of week (Sunday midnight) using the time for the chart 

g. Start of Month – Start of the month (midnight) using the time zone set for the 

chart (enabled by default). 

h. Start of Year – Start of the year (midnight Jan 1) using the time zone set for the 

chart (enabled by default). 

12. Copy Exit Strategy – A copy button has been added to the Exit Strategies Panel (See 

Trade Panel Preferences and DOM Preferences dialog). 

Version 6 Beta 3D 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Guide Templates – Templates have been added for price and time guides.  See 

properties dialog when creating or editing a guide.  Guides for a specific template can be 

added directly from the right click menu on the price or time axis. 

2. Scanner – Added the number of results in the “Scan Complete” message 

3. Center DOM Shortcut – Added a new keyboard short cut option “Center On Last Price” 



(default unassigned).  This will re-center the active DOM on the last price. 

4. Lock/Unlock Components – This action will toggle the locking of components on the 

active chart (instead of locking components individually).  (See View -> Lock/Unlock 

Components from the menu bar) 

5. NADAQ Hours – Modified extended hours from 7-20 EST to 4-20 EST 

6. SDK Aggregate & Filter Ticks – Two new options have been added to the Study 

Header (false by default).  If these options are enabled, the user will be able to configure 

the settings in the “Options” tab of the study dialog. 

a. allowTickAggregate – If true, the user will be given the option aggregate tick 

data using the given aggregate period in milliseconds 

b. allowTickFilter – If true, the user will be given the option to set a min and or 

max trade size to be filtered before passing the data to the study. 

c. Affected Studies – these options have been turned on for the following studies: 

Volume Imprint, Delta Volume, Cumulative Delta, Bid/Ask Volume 

7. Volume Imprint –  

a. Disable Column1 - Added option disable the display of Column 1.  This will 

effectively hide the imprints, but allow you to show the totals at the bottom of the 

chart. 

8. Roll Next Contract – Added an option to roll instrument settings to the next contract.  

This includes the historical instrument and options under the Advanced tab (see 

Instrument Dialog). 

9. Break Even Offset – Added an optional offset (in ticks) to the Break Even button (when 

customizing from the Trade or DOM panel). 

Version 6 Beta 3C 

This version of MotiveWave contains numerous bug fixes and the following features: 

1. Custom Order Actions – A custom order can be defined and assigned a keyboard 

shortcut (Professional Edition and above).  This option is available under the General 

Preferences Dialog (Configure -> Preferences from the Console menu bar).  Click on 

“General” then on “Keyboard” then on “Custom Orders” 

2. Quantity Shortcuts – Keyboard shortcuts can be assigned to preset quantities (see Order 

Presets dialog from the Edit Instrument Dialog).  By default, the number keys 1-9 will 

set the quantity to the preset quantity for the instrument in numerical order.  Shortcuts 

can be modified from the Keyboard tab in the General Preferences Dialog (Configure -> 

Preferences from the Console menu bar) click on “General” then on “Keyboard” 

3. Dock Shortcuts – The following keyboard shortcut options have been added for 

navigating pages, stations and tabs in the docking framework (unassigned by default, see 

Preferences Dialog -> “General” -> “Keyboard”): 

a. Next/Previous Page – Sets the active page to the next/previous page. 

b. Next/Previous Station –When a station is maximized these actions will move to 

the next / previous dock station (same as the left/right arrow icons in the dock tool 

bar) 

c. Next/Previous Tab – Sets the active tab on the active station to the next/previous 

tab. 

4. Delete Expired Instruments – Expired instruments (futures contracts and options) can 

be removed from the workspace in the Manage Instruments Dialog (Configure -> 



Instruments in the Console menu bar).  See: Delete Expired button at the bottom of the 

dialog. 

5. PL Price Movement – Options are now available to display the P/L as a price movement 

(instead of a dollar amount): 

a. Trade/DOM Panel – (Pro Edition and above) an additional widget has been 

added “P/L Price Label” to display the Profit/Loss as a price movement. 

b. DOM PL Price Column – This column has been added to show the P/L as a 

price movement. 

6. TPO Study – Added a Font/Font Color option for Letters displayed in the ETH session 

(see Display tab –> Letters ETH) 

7. Volume Imprint –  

a. Added option to toggle display of totals in the summary profile (see Summary 

Profile tab -> Show Totals) 

b. Font Colors – Added options to change the color for labels in the Volume 

Profile, Bid/Ask, Ladder, Volume, Delta and totals 

8. Horizontal Line Tool – Added a mouse tool for creating a horizontal line.  See tools 

drop down (hand cursor by default). 

9. Line Graph Label – Added the symbol to the price graph when displayed as a line 

graph. 

10. Visibility Options – Added the following visibility options to the Visibility tab (see 

Component Properties Dialog): 

a. Visible On Current Bar Size Or Higher – Sets the visibility to be GTE current 

bar size 

b. Visible On Current Bar Size Or Lower – Sets the visibility to be LTE current 

bar size. 

11. Reverse Button – The functionality of this button has been changed to cancel all open 

orders (for the instrument/account) before reversing the position. 

Version 6 Beta 3B 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 3A 

Version 6 Beta 3 contains many new features.  For details see the What’s New In Version 6 

Beta 3 Guide. 

 

List of new Features: 

1. Exit Strategies 

2. Custom Trade Panel 

3. Custom DOM Panel 

4. Analysis Packs 

5. Elliott Wave Markers 

6. Roll Futures Contracts 

7. Much more, see Beta 3 Guide 

https://www.motivewave.com/guides/Whats_New_Version_6_Beta3.pdf
https://www.motivewave.com/guides/Whats_New_Version_6_Beta3.pdf


Version 6 Beta 2E 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 2D 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 2C 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 2B 

This version of MotiveWave includes numerous bug fixes and the following enhancements: 

1. Object Viewer – Components can be locked directly in the Object Viewer (View -> 

Object Viewer from the top menu bar) 

 

Version 6 Beta 2A 

Version 6 Beta 2 contains many new features.  For details see the What’s New In Version 6 

Beta 2 Guide. 

 

List of new Features: 

1. Elliott Wave Custom Ratios 

2. Market By Order 

3. DOM Enhancements 

4. Rithmic Enhancements 

5. TPO Split/Merge 

6. Volume Imprint Enhancements 

7. DOM History Enhancements 

8. Bid Trades Study 

9. OHLC Study 

10. Volume Profile Study Enhancements 

11. Time & Sales Enhancements 

12. SDK Enhancements 

Version 6 Beta 1H 

This version of MotiveWave includes numerous bug fixes and the following enhancements: 

1. Rithmic – Updated to the latest API release 10.6.0.0 

https://www.motivewave.com/guides/Whats_New_Version_6_Beta2.pdf
https://www.motivewave.com/guides/Whats_New_Version_6_Beta2.pdf


Version 6 Beta 1G 

This version of MotiveWave includes numerous bug fixes and the following enhancements: 

1. Rithmic DOM Levels – Support for all Depth of Market levels returned from Rithmic 

API (20+ bid/ask levels) 

2. Volume Imprint/TPO Study – Some significant performance enhancements have been 

added to this update for these studies. 

3. Java 12 – Updated to the latest version of Java and JavaFX 

Version 6 Beta 1F 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 1E 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 1D 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 1C 

This version of MotiveWave includes numerous bug fixes and the following enhancements: 

1. DOM Location – This option allows you to display the DOM panel on the left or right 

side of the chart. See DOM Panel -> Preferences -> General Panel. 

2. Time and Sales Location – This option allows you to display the Time and Sale panel 

on the left or right side of the chart. See TS Panel -> Preferences. 

 

Version 6 Beta 1B 

This is a bug fix only release.  No new features are included in this update. 

Version 6 Beta 1A 

Version 6 contains many new features.  For details see the What’s New In Beta 6 Guide. 

 

Please Note: This is a beta version of MotiveWave™ and may contain more issues that a regular 

release.  Please report any issues to support@motivewave.com. 

 

List of new Features: 

1. Cloud Workspaces 

2. Custom Watch List Columns 

https://www.motivewave.com/guides/Whats_New_Version_6_Beta1.pdf
mailto:support@motivewave.com


3. Gauges 

4. Advanced DOM  

5. Auto Backup 

6. Log File Trimming 

7. Watch List Flags and Filtering 

8. New Components/Tools 

9. Component Templates 

10. Continuous Contracts 

11. Alert Colors 

12. CryptoCompare API – Added support for API Key 

13. Replay Mode in Trade Edition 

  


